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Financial Modelling

The IPM Financial Planner is a ready to use business application module for the Microsoft® Excel 
spreadsheet. This versatile product is a member of IPM's Business Solution Series and is designed to 
satisfy a wide range of financial planning needs. IPM have harnessed the powerful features available in 
Microsoft® Excel to give you one of the most comprehensive business products available today.

Potential users who would benefit from this application include:

· Financial Managers
· Product / Project Managers
· Development Managers
· Small Business Operators
· Departmental Managers
· Consultants

It is particularly relevant to those working in:

· Small Business Ventures
· Business Units
· Project Management
· Departmental Management
· Financial Management
· General Management
· Consultancy

The Financial Planner can be used on its own or as part of an integrated suite. Information generated 
using the Financial Planner can be consolidated* with that from Product Viability Models* to provide a 
comprehensive financial overview.

* using other IPM Products.



Overview

The Financial Planner is a professional business tool that can be used by businesses in many market 
sectors. In large establishments for example, it makes an ideal planner for departmental budgeting and 
Financial Project Management. Small independent businesses will find this product an essential tool for 
monitoring performance and managing cash flow. Comprehensive financial plans can be created quickly 
and efficiently without the need for in depth specialist knowledge.

The Financial Planner is both functional and easy to use. Colour coded templates and navigational maps
provide the user with a modern, ergonomic interface. On line help is provided in the form of cell notes that
can be viewed automatically in Excel 7 (when the mouse cursor is placed above that cell note indicator) 
or viewed manually in Excel 5 (accessed from tool bar).

The financial plan framework can be created entirely from scratch or, to save valuable time, copied from 
existing plans. Powerful editing facilities allow you to add or delete account codes as required. Once you 
are happy with the framework, actual results can be entered on a month by month basis, the effects of 
which can be analysed and printed out to form the basis of a financial report.

Features
· 12 month in view financial planner
· Profit and Loss accounting
· Actual against Budget tracking
· User defined account names
· Optional VAT status on accounts
· Capital expenditure accounts
· Depreciation
· Variance analysis
· Cash flow forecasting



Creating a Financial Plan

In common with many professional planning tools you must first decide upon how to structure the financial
elements of your plan. When you are ready to begin, follow the steps below.

Account Codes
The majority of the numerical data you enter into the plan will relate to income received and expenses 
incurred. For ease of input and later analysis, each entry you make should be assigned to an account 
code.

You can either create the account codes from scratch or copy them from an existing plan (you may, if you 
wish, copy the codes from the examples).

Start the Financial Planner. On the Financial Planner menu bar several sub menu items become 
available.

Create a new plan by selecting New Plan on the Financial Planner menu bar.

On the first sheet you are presented with a navigational map which will help guide you around the 
Workbook. You will be able to return to this sheet by simply clicking on the HOME button (a HOME button 
is available on the top left hand corner of each sheet in the workbook).

The template will provide you an with empty plan to which you must add your own account codes. To do 
this use the Edit Account CodesM_EDIT_ACCOUNTS or Copy Account CodesM_EDIT_ACCOUNTS 
commands on the Financial Planner menu bar. 

Plan Settings
Once you are happy with the account codes you will need to configure the parameters relating to Capital 
Expenditure, Depreciation, Credit Terms and VAT. Each of these are configured using the Settings item 
on the Financial Planner menu bar.

Do not worry if you have not entered all of the details. You can go back and modify any of these items at 
any time during the creation of the plan.

Entering Budgets and Creating A Forecast
You can now enter financial data. Start with the Current Budget and Capital Budget. 

The Budget will be the benchmark against which future performance is monitored. Once created, this will 
normally only be changed if you need to produce a revised budget for your operation.

Once you are happy with the budget, you must create a Working Forecast. The initial forecast is created 
by making a direct Copy of the Current Budget. 

You can now review the overall profitability and cash flow for your operation. If you need to revise your 
estimates in the light of this review, return to the Current Budget, adjust the data as necessary and re-
create the Working Forecast using the Copy facility. You can repeat this process any number of times, 
until you are happy with the plan.

Having created your Financial Plan. Over the next 12 months, you can use it to monitor the performance 
and forecast the result of your operation.



Using a Financial Plan to Monitor Performance

At the end of each month, you should update your Working Forecast by entering actual results and if 
necessary re-forecasting the remaining income and expenses.

Having entered the actual results for the period, you should review the remainder of the forecast to 
ensure that the overall forecast remains accurate. For example if a predicted expense did not occur in the
period just closed but you know that it will still be incurred, then you should re-enter it in a later period.

When you are happy with your revisions you may view or print the updated Working Forecast, Summary 
and Cash Flow Forecast as required.



Platform Requirements

In order that you achieve best results from the application, the MINIMUM hardware requirement is an IBM
or Compatible PC 486DX66 (Pentium recommended); 8 Mbytes of RAM, VGA or better (SVGA 
recommended).

The Financial Planner requires that your machine is running either 
Windows 3.1 and Microsoft® Office with Excel Version 5 

or 
Windows 95 and Microsoft® Office Version 7 or Excel Version 5 or 7.



Starting the Financial Planner 
If you are running Windows 95, the install Add In will add an Innovation Process Management folder to 
your Programs group. To create a new or open an existing Financial Plan click Start - Programs - 
Innovation Process Management - Financial Planner from the Task Bar.

If you are running Windows 3.1, the install Add In will create a new Program Manager group containing 
the application icons. To create a new or open an existing Financial Plan double-click the Financial 
Planner icon in the Innovation Process Management program group.



Example Plans
Two example files are included to help you get started. These files are loaded into your IPM directory 
during the installation process.

fplanex1.xls - A small business venture developing and manufacturing water level indicators,

fplanex2.xls - A product division within a large company developing and manufacturing widgets.

Data included in the example files are totally fictitious and intended for example use only.

By exploring the two examples the principles behind the Financial planner can be easily seen. Financial 
data and parameter settings can both be modified as required by the user.

If you wish, you may copy the account codes used in the examples. This will enable you to create a new 
template for your own plans. Please do not try and use the example sheets directly for your own 
purposes. Both plans have actual results posted and once a financial year is underway, it cannot be reset.



Installing and De-Installing the Financial Planner

Installation Disk Contents
The installation disk comprises the following key elements :

1. Installation program

2. Financial Planner program files. (Excel Add In and Excel template).

3. Help file (installation and user help)

4. Financial Planner example plans

Installing Financial Planner
To install the files on your hard disk, first close all applications, including Excel, and run the install Add In 
'setup.xla' from the release disk. You can do this by:

1. Opening Excel and choosing File Open a:\setup.xla

2. In Windows 3.1 from either Program Manager or File Manager choose File Run and type a:\
setup.xla in the Command Line box.

3. In Windows 95 click Start and select Run, then type a:\setup.xla in the Open box.

Note: Replace a:\ with b:\ as appropriate for your machine.

Microsoft Excel must be installed on your computer before you install the Financial Planner.

The installation program will automatically guide you through the installation process prompting you for 
information as required.

De-Installing Financial Planner
The Financial Planner application comprises of a spreadsheet template and Add-In module for Microsoft®
Excel. There are no executable programs or libraries and the installation process makes no changes to 
the Windows registration database. 

All IPM Financial Planner program files are located in the directory selected during the installation process
(by default this was C:\IPM).

To de-install the application:

1. If you have placed any of your own data files in the IPM directory, move them to another location.

2. Using either File Manager or Explorer simply delete, from the installation directory, all files with 
names beginning with the initial letter F.

3. If you do not have any other IPM applications installed, delete the installation directory using 
either File Manager or Explorer.

4. In Windows 3.1 using Program Manager, delete the Financial Planner application icons from the 
Innovation Process Management group box. If you do not have any other IPM applications 
installed, delete the Innovation Process Management group box.

5. In Windows 95 click Start - Settings - Task Bar. On the Task Bar Properties dialog box, Click Start 
Menu Programs - Remove. In the directory list window click + next to Innovation Process 
Management then highlight and remove the Financial Planner shortcuts.



Trial Users
Trial Users should follow the instructions regarding the program installation and when prompted for a Disk
Key should leave the box blank.

The Financial Planner will be installed and remain fully operational for a period of 30 days.

Please note: Financial plans created by the trial version can not be opened after the 30 day time 
period and any data entered can not be transferred to the full version.

For further information regarding price and availability please open the Order workbook (order.xls) located
in the IPM directory.



Financial Plan Architecture

Each plan created by the Financial Planner is a self contained Microsoft® Excel Workbook.

The first sheet in the book is a navigation map which provides an easy method for entering and accessing
data.

Once you have loaded a plan, you may go to a particular area of interest or initiate an update process by 
simply clicking on the coloured boxes on the map.



Business Solution Series

IPM has created a comprehensive range of business tools. Other products in the series include:

· Product Viability Model
· Bid Management
· Marketing Communications
· Visual Mapping
· Marketing Audit

For further information regarding price and availability of these modules please open the Order Form 
workbook (order.xls) located in the IPM directory.



Current Budget

The Current Budget is a 12 month in view sheet. The new financial budget to be monitored is entered into
this sheet. 

The Current Budget is the benchmark against which performance is measured. The expected revenue 
and expenditure for a 12 month period should be entered into this sheet. 

The Current Budget sheet includes consolidated Capital Budget accounts which are automatically linked 
from entries in the Capital Budget sheet.

Current Budget entry categories include:

· Income
· Direct Costs
· Indirect Costs
· Depreciation (Capital)
· Assets (fixed and other)
· Liabilities
· Number of personnel

The summary (including ratios) of the data entered in this sheet can be viewed at any time.

Once you are satisfied with the Current Budget you may copy this into the Working Forecast.



Working Forecast

The Working Forecast is a 12 month in view sheet.

Initially this will be a direct copy of the Current Budget. During the period of the Financial Plan, this sheet 
is progressively updated (on a month by month basis) with the forecast data being replaced by actual 
result. At the end of the 12 month period the Working Forecast will represent the actual result for the 
entire period of the plan.

The Working Forecast entry categories include:

· Income
· Direct Costs
· Indirect Costs
· Depreciation (Capital)
· Assets (fixed and other)
· Liabilities
· Number of personnel

A summary (including ratios) of the data entered in this sheet can be viewed at any time.

A graphical representation of the period of the plan provides an instant comparison between Budget and 
Actual performance.



Capital Budget

The Capital Budget is a 12 month in view sheet. You can enter scheduled capital purchases that you plan 
to make.

The details for each of the Capital Accounts may be configured using the Settings item on the Financial 
Planner menu bar. These details include:

Capital Account names

Depreciation Method

Depreciation Period

Entries made in this sheet are automatically linked to accounts in the Current Budget.



Copy Budget to Forecast

Once you are satisfied with the Current Budget, the Copy facility transfers this data into the Working 
Forecast.

To Copy current budget to working forecast simply click on the Copy button on the navigation map.

Transferring budget to forecast does not restrict you from revising the Current Budget at any time.

This process can only be performed before Actual results are posted in the plan.



Enter Actual Results

Once monthly results for your operation become available, you should enter them into the Working 
Forecast.

To enter results into working forecast simply click on the Enter Actual Results button on the navigation 
map.

On clicking the Enter Actual Results button the Current Period is closed, the period number is 
incremented and the Working Forecast data for that period is cleared. You will be guided to the newly 
cleared column and prompted to enter your actual results.

Take care when entering actual results. Once the period number has been incremented there is no way of
decrementing it again.



Cash Flow Forecast

The Cash Flow Forecast is a 12 month in view sheet. The cash flow is calculated automatically from the 
data entries and parameters collated from the other sheets.

Initially the whole period is a Forecast. During the period of the Financial Plan, this sheet is automatically 
updated (on a month by month basis) with the forecast data being replaced by actual result. At the end 
of the 12 month period the Cash Flow Forecast will represent the actual result for the entire period.

A graphical representation of 'cash change' and 'cumulative cash position' is included on this sheet. By 
entering your overdraft limit you can easily identify any cash flow problems.

Cash Flow categories:

· Actual / Forecast
· Cash / Credit payments 
· Other receipts / payments
· Cash Flow
· Overdraft limit 
· Credit transactions
· VAT summary
· Graph (Cash Flow)



Summary

The Summary provides an overview of the financial plan showing Actual, Budget and Variance against 
Current Period, Year to Date and Full Year. 

Key financial ratios provide an indication of business performance.

Summary information in view:

· Income 
· Direct Costs
· Indirect Costs
· Depreciation
· Balance sheet changes (Assets and Liabilities)
· Personnel
· Key financial ratios (Gross Profit, Profit / Loss, Margin, Break even, Profit / employee,    Turnover / 

employee)



Menu Command Summary

All of the functions required to generate financial plans and adjust their settings are accessible from the 
Microsoft® Excel menu bar.

If there are no workbooks open, the Financial Planner menu will be at the bottom of the File menu, if a 
worksheet is displayed, it will be at or near the bottom of the Tools menu.

The cascaded menu on the Financial Planner menu contains the following items:

New plan

Open existing plan

Consolidate

Details

Settings

Edit account codes

Copy account codes

About



New Plan Command

The New Plan menu command creates a new financial plan.

Each time you create a new plan, you will be prompted to enter the basic details of the plan. These 
include:

Product / Division

Plan Author

Year end date

If you wish, you may change these entries later by clicking Settings on the Financial Planner menu.

Every plan you create is a self contained Excel Workbook.



Open Existing Plan Command

The Open Existing Plan menu command opens a previously created financial plan.

You can open several plans simultaneously. One or more windows on each plan can be viewed and data 
compared or transferred as required. Use the Window menu to switch between plans.



Consolidate Command

This option is available as an upgrade. When installed it enables the information in many individual 
financial plans to be consolidated into a single summary. 

Financial plans may be consolidated together in either series or parallel modes.



Details Command

This option allows you to change the basic details of the plan. These details would normally have been 
entered at the time the plan was created. They include:

Product/Division

Plan Author

Year end date



Settings Command

The Financial Planner provides a number of global settings which may be changed to suit individual 
organisational requirements. These include specific parameters concerning:

Capital Expenditure Account names

Depreciation Method

Depreciation Period

Credit Terms for all accounts

VAT details for the plan

These settings may be changed at any time. The effects on the plan are immediately observable.



Edit and Copy Account Code Commands

The Edit Account Code command enables you to add, delete or change the account codes in the 
financial plan. Account name, or sub-group coding changes can be made at any time.

If you wish, you may save an account code set from an existing plan into the master template. By doing 
this, any new plans created will automatically include this default set.

The Copy Account Code command provides a powerful facility enabling a complete account code set to
be copied from an existing plan. You can optionally append to, or replace the codes in your plan with 
those from the selected plan. Using this method provides an easy way of generating follow on years, 
based on an existing plan.

Any changes to the Account Code Database must be applied to the existing worksheets in the plan. The 
program will automatically do this for you when exit the Edit or Copy screens. You will be warned that the
codes in the database do not correspond to those in the worksheets. If you wish, you may delay this 
process until later - simply answer No to the warning message and return to the Edit Account Code 
command and click OK at a convenient time.

Note
The rebuild process will not delete an account row from the Current Budget or Working Forecast sheets if 
either of them contains data. You will need to delete or move the data before the row is removed.

Similarly, if you move an account code between sub-groups (for example changing an account from 
Direct to Indirect) the old code is deleted and a new code added. Any existing data in either the Current 
Budget or Working Forecast must be moved before the rebuild process will remove the row. The rebuild 
process does not move data entries.



About

This command allows you to view the version and build number of the program and workbooks. It must be
quoted in the event of any technical or user queries.



You may specify the Depreciation Period for each of the asset groups. It is the time over which the asset 
will have a book value of Zero.



You may configure assets to be depreciated using either the Reducing Balance or Straight Line methods.



The first sheet in each Financial Planner workbook is a navigation map. This provides an easy method for
entering and accessing data. To go to a particular area of interest, simply click on the appropriate 
coloured box on the map.



Series Consolidation enables plans spanning several years to be summarised into a single result. For 
example if a design project takes three years to complete, three detailed financial plans representing each
of the three years can be summarised to give a budget, cost to date and forecast to complete for the 
entire development.



Parallel Consolidation enables several plans for the same year to be summarised into a single result. 
For example if an organisation is split into different departments or divisions, individual financial plans for 
each of these departments or divisions can be summarised to give an overall view of budget, cost to date 
and forecast for the whole organisation.



The Current Period for a plan is the first month for which there is no actual data available. For a new 
plan the Current Period is month one. As the plan progresses and actual data is entered, the Current 
Period is incremented until period 12 when all data in the Working Forecast is actual data.



When you installed the application, you entered your Company Name. The Product / Division entry may 
be used to describe a sub-category of the Company Name. For example, if the plan is for a division or 
department within the company, use this field to identify the name of the division or department; if the plan
is for a Project, use this field to identify the Project Name.



The Plan Author is individual responsible for compiling and maintaining the plan.



The Year End Date of each plan is normally the same as the accounting year end for the company. If you
intend to consolidate plans, it is important that the Year End Date be entered correctly.



Credit Terms are specified as the number of months of credit given to you by your Suppliers and the 
number of months taken from you by your Customers. These entries are used in the generation of the 
Cash Flow forecast.



If you wish to account for VAT you should enter the month when VAT payments start, the VAT interval and
the VAT rate. Only one rate of VAT is allowed. You should enter the most appropriate rate for your 
business.

Adjustment to allow for variations in VAT may be entered in the Other Receipts / (Payments) section of 
the Cash Flow Forecast.



An Account Code comprises of a unique Name (against which entries are stored) and a code which 
defines the Credit Terms, VAT status and Category (income, direct expense or indirect expense) for the 
data.




